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CHAPTER 1

SOFTWARE INSTALLATION
1.1

Installing DataView®
DO NOT CONNECT THE INSTRUMENT TO THE PC BEFORE INSTALLING THE
SOFTWARE AND DRIVERS.

Minimum Computer Requirements:
•

Windows XP / Windows Vista & Windows 7 (32/64 bit)

•

256MB of RAM for Windows XP
1GB of RAM for Windows Vista & Windows 7 (32 bit)
2GB or RAM for Windows Vista & Windows 7 (64 bit)

•

80MB of hard disk space (200MB recommended)

•

CD-ROM drive

Windows is a registered trademark of Microsoft Corporation in the United States and other countries.

NOTE: When installing, the user must have Administrative access
rights during the installation. The users access rights can be changed
after the installation is complete.
DataView® must be reinstalled for each user in a multi-user system.

1. Insert the DataView® CD into your CD-ROM drive.
If auto-run is enabled, the Setup program will start automatically. If
auto-run is not enabled, select Run from the Start menu and type in
D:\SETUP (if your CD-ROM drive is drive D. If this is not the case,
substitute the appropriate drive letter).

NOTE: If installing onto a Vista based computer the User Account Control
dialog box will be displayed. Select the Allow option to proceed.
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2. A Set-up window, similar to the one below, will appear.

Figure 1-1

There are several different options to choose from. Some options(*) require
an internet connection.
•

DataView, Version x.xx.xxxx - Installs DataView® onto the PC.

•

*Adobe Reader - Links to the Adobe® website to download the
most recent version of Adobe® Reader to the computer. Adobe®
Reader is required for viewing PDF documents supplied with
DataView® that are accessible from the Help menu.

•

MetaViewer - The MetaViewer utility program allows a user to
view and print .dmf or .emf files generated by DataView® without
having DataView® software installed.

•

*Software Updates - Links to the AEMC® Software Update
website to check for new software version releases.

•

*Firmware Upgrades - Links to the AEMC® Firmware Upgrade
website to check for new firmware version releases.

•

Documents - Shows a list of instrument related documents
that you can view.  Adobe® Reader is required for viewing PDF
documents supplied with DataView®.

3. DataView, Version x.xx.xxxx option should be selected by default.
Select the desired language and then click on Install.
4. The Installation Wizard window will appear. Click Next.
Simple Logger® II - DataView® Software
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5. To proceed, accept the terms of the license agreement and click Next.
6. In the Customer Information window, enter a Name and Company,
then click Next.
7. In the Setup Type window that appears, select the “Complete” radio
button option, then click Next.
8. In the Select Features window that appears, select the instrument’s
control panel that you want to install, then click Next.

NOTE: The PDF-XChange option must be selected to be able to generate
PDF reports from within DataView®.

Figure 1-2

9. In the Ready to Install the Program window, click on Install.
10. If the feature selected for installation requires the use of a USB port, a
warning box will appear, similar to Figure 1-3. Click OK.

Figure 1-3
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NOTE: The installation of the drivers may take a few moments. Windows may
even indicate that it is not responding, however it is running. Please wait for
it to finish.
11. When the drivers are finished installing, the Installation Successful
dialog box will appear. Click on OK.
12. Next, the Installation Wizard Complete window will appear. Click on
Finish.
13. A Question dialog box appears next. Click Yes to read the procedure
for connecting the instrument to the USB port on the computer.

NOTE: The Set-up window remains open. You may now select another option
to download (e.g. Adobe® Reader), or close the window.
14. Restart your computer, then connect the instrument to the USB port
on the computer.
15. Once connected, the Found New Hardware dialog box will appear.
Windows will complete the driver installation process automatically.
Shortcuts for DataView® and each instrument control panel selected during
the installation process have been added to your desktop.

NOTE: If you connected your instrument to the computer before installing
the software and drivers, you may need to use the Add/Remove Hardware
utility to remove the instrument driver before repeating the process.

Simple Logger® II - DataView® Software
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CHAPTER 2

Simple Logger® II Control Panel
2.1

Opening the Control Panel

To open the Simple Logger® II Control Panel:
•

Double-click the Simple Logger II Icon that was created during
installation, located on the desktop.

•

The Connection window will appear (see Figure 2-1).

NOTE: When connecting using the Simple Logger II icon and only one Simple
Logger II is connected to the computer, it will be selected and a connection
will be established automatically.

Figure 2-1

The Connection window specifies the connected instrument in the communications drop-down list.
If multiple units are attached, select the desired unit with its associated
serial number from the drop-down list.
Once the desired instrument has been selected, click OK and the Simple
Logger® II Control Panel and Real-time windows will be displayed (see
Figure 2-2).

NOTE: The default layout can be changed by moving and resizing each
window (see § 2.5 - Resizing and Saving Window Layouts).
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TIP: Click on the Arrange Window icon
located at
the top right of the toolbar to expand and arrange all the
windows evenly, all at once.



TIP: For complete instructions and information on using
DataView®, refer to the Help Menu within the software.

2.2

Using the Control Panel

The Control Panel is used for instrument operation and configuration.
To open the Control Panel either click on the Control Panel option from
DataView’s main Instrument menu or double-click on the Simple Logger®
II desktop icon.

Figure 2-2
Simple Logger® II - DataView® Software
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The main menu at the top of the screen lists the following commands:
File
Load Layout - loads a real-time window layout.
Save Layout - saves the current real-time window layout.
Start recording real-time data - stores real-time trend data into a
specified database.
Print - prints the selected real-time window.
Print Preview - provides a preview of the real-time window to be
printed.
Print Setup - displays a Print Setup window allowing you to select a
destination printer and change various printing options.
Exit - closes the control panel
View
Trend - opens a real-time trend graph window.
Waveform - opens a real-time waveform window.
Harmonic - opens a real-time harmonic bar graph window.
Status - opens a real-time window displaying status information about
the connected Simple Logger® II.
Instrument
Connect - establishes a connection.
Disconnect - closes a connection.
Configure - displays the instrument configuration window.
Download - downloads recorded data stored in the Simple Logger® II.
Start/Stop Recording - If the instrument is not recording, this menu
option will read as Stop Recording and when selected sets the recording start time to now. The stop time will be set to the current time
plus the original recording duration. If the instrument is recording, this
menu option will read as Stop Recording and will terminate the recording when selected.
Clear Alarms - Resets the alarm indication on the instrument, as well
as in the status window of the Control Panel.
Erase Memory - erases all recorded data stored in the instrument.
8
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Tools
Channel Trace Colors - allows you to specify the default colors to
be assigned to graph traces associated with specific trend measurements.
Input Trace Colors - allows you to specify the default colors to be
assigned to graph traces associated with specific hardware input
channels.
Decode Data File - Allows you to load a download.dat file.
Window
Cascade - arrange all windows into a stack, with each window offset
slightly.
Tile - display all windows equally sized without overlapping.
Arrange Windows - arrange the real-time windows into a default
layout based on the size of the main control panel window.

NOTE: In addition, a list of open real-time windows is displayed at the bottom
of the Window menu. Selecting one of these options will activate the associated real-time window. This is useful when other windows hide a desired
window.
Help
Control Panel - display the main Control Panel help topic.
Contents - display the help contents dialog box.
How To - display the How To help topic.
About - displays the About dialog box.

Simple Logger® II - DataView® Software
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2.3

Configuring the Simple Logger® II

To Configure the Simple Logger® II, perform the following steps:
1. Open the Simple Logger® II’s Control Panel and connect to an instrument (refer to § 2.1 if you are unsure how to open the Control Panel).
2. Next, select Configure from the Instrument menu and the Configure
Instrument dialog box, similar to Figure 2-3, will be displayed.

NOTE: The configuration of an instrument cannot be changed while a recording is in progress. You must click on Stop Recording before proceeding.
The first tab (Recording) allows you to define the Storage Rate and
Recording Mode.

Figure 2-3

This Recording tab allows you to define:
Storage Rate – rate at which sampled data is stored in the recording.
Recording Period – duration of the recording.
Start Time of Recording – time to start and end the recording.
10
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Record Now: forces a recording to start as soon as the configuration
is applied (date/time fields are grayed when this is selected).
Reset Date/Time: sets the start and end date and time.
Erase: pressing this button will erase all measurements and alarms that
are stored in memory.
Storage Mode – how to handle the storage of data when the memory
becomes full.
•

Start/Stop - will cause the recording to start at the specified time
and continue until memory becomes full or the recording end time
is reached (which ever occurs first).

•

FIFO - will cause the recording to start at the specified time and
continue until the recording end time is reach.  If memory becomes
full before the end time, the oldest samples are discarded until the
recording terminates. This results in a duration that is dependent
on the amount of memory and the storage rate.
(e.g. if the storage rate and available memory allows for an 8
hour recording, and a 24 hour period was selected to record, the
sample stored will cover the last 8 hours in that 24 hour period.)

•

XRM™ - will cause the recording to start at the specified time
and continue until the recording end time is reached. If memory
becomes full before the end time, every other sample is discarded
(freeing up half of the memory), the storage rate is cut in half and
storage continues. This repeats until the recording end time is
reached. This results in a recording that contains samples covering the desired recording period with the sample rate adjusted to
accommodate that period.

Starting Mode – how to start a recording, without regard for storage rate
or synchronized to the storage rate.
•

Normal - will cause the recording to start at the specified starting
time without regard for storage rate.

•

Synchronous - will cause the recording to start synchronized to
the storage rate.
For example, if the storage rate is set to once every 5 seconds,
the recording will start at 0, 5, 10, 15, 20, 25, 30, 35, 40, 45, 50 or
55 seconds on the minute. The recording will start at the next synchronous starting point after the specified starting time. If the start
time falls at a synchronous boundary then the recording will start
at the specified time. The start time is different from the specified
time only when it is not at a synchronous boundary.

Simple Logger® II - DataView® Software
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Set Clock - displays the Date/Time dialog box for setting the date/time in
the instrument.
Measurement Setup – lists the channels available to be recorded.
Record - if more than one channel is listed in the measurement setup, you
can enable/disable the recording of each channel by selecting/deselecting the
Record checkbox.  At least one channel must be selected for recording.

2.3.1

Setting Recording Options

Start/Stop Recording Mode
Select the Start/Stop radio button.
Recording Start:
Specify a start date and time by performing one of the following:
•

Select the Record Now button. This will set the Recording Start
date and time to the current date and time plus one minute.

•

Enter the start date and time in the associated edit boxes.

Recording End:
Specify an end date and time by performing one of the following:
•

Select a time under Recording Period. This will set the Recording
End date and time to the Recording Start date and time plus the
selected time duration.

•

Enter the end date and time in the associated edit boxes.

FIFO Recording Mode
The FIFO mode operates much like the Start/Stop mode with the exception that the recording does not stop when memory becomes full.
When this happens, the oldest sample set is discarded to make room for
the new sample set. The instrument will record the most recent samples
until the user stops it or the recording end time is reached.
Select the FIFO radio button.
Recording Start
Specify a start date and time by performing one of the following:
•
•
12

Select the Record Now button. This will set the Recording Start
date and time to the current date and time.
Enter the start date and time in the associated edit boxes.
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Recording End:
Specify an end date and time by performing one of the following:
•
•

Select a time under Recording Period. This will set the Recording End date and time to the Recording Start date and time plus
the selected time duration.
Enter the end date and time in the associated edit boxes.

XRM™ Recording Mode
The XRM™ mode operates much like Start/Stop mode with the exception
that the recording does not stop when memory becomes full.
When this happens, every other sample is discarded, memory is
compacted and storage continues at 1/2 the storage rate. This mode of
recording adjusts the storage rate in order to keep the recording going. The
instrument will continue to record until the user stops it or the recording
end time is reached.
Select the XRM™ radio button.
Recording Start
Specify a start date and time by performing one of the following:
•
•

Select the Record Now button. This will set the Recording Start
date and time to the current date and time.
Enter the start date and time in the associated edit boxes.

Recording End:
Specify an end date and time by performing one of the following:
•
•

Select a time under Recording Period. This will set the Recording End date and time to the Recording Start date and time plus
the selected time duration.
Enter the end date and time in the associated edit boxes.

Common Recording Options
Read - reads the configuration inside the attached Simple Logger® II and
resets the field options based on the instrument’s current configuration.
Load - allows the user to select a previously saved instrument configuration.
Save - saves the current configuration to a file.
Download: Downloads recorded data from the instrument.
Simple Logger® II - DataView® Software
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The Configure Instrument window also contains a memory status
area. This area displays the amount of memory used, the amount of
available memory and the amount of memory required for the selected
configuration.

2.3.2

Setting Scales Options

The second tab (Scales) allows you to define:
Input scale - for inputs that have fixed scales this option is disabled. For
inputs that are not fixed (current clamps for example) you can specify a
scale for the input. For example 1V = 1000A.
Offset - for instruments that allow a user offset this will be displayed.
The offset is applied to measurement values when measurements are
downloaded from the instrument. This value can be positive or negative.
Linearity - for instruments that allow a user specified linearity adjustment
this control will be displayed. The linearity adjustment allows you to specify
different multipliers for different ranges of measurements. The linearity is
applied to measurement values when measurements are downloaded
from the instrument.
Units - for instruments that allow user specified measurement units, this
control will be displayed. It allows you to over-ride the default measurement
units of the instrument.
Temperature Units - this option is only available and displayed when
configuring a TC logger. This option allows you to select between the three
temperature units (Celsius, Fahrenheit and Kelvin), in addition it allows
you to display the raw voltage measurement of each input.
TC Type - this option is only available and displayed when configuring a TC
logger. It allows you to select between the Thermocouple types supported
by the instrument. This selection will apply to all TC inputs. Multiple TC
types cannot be used at the same time with the Simple Logger II.
Filter - this option is only available and displayed when configuring
instruments that support input filtering. It allows you to select the level of
filtering (averaging) of measurements. Filtering is performed by averaging
the last x values measured on an input. Next to each filter name (in
parenthesis) is the number of samples averaged. A Filter of None provides
no filtering and simply results in individual measurements being stored.
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Figure 2-4

NOTE: Not all options shown may be available. The Scale tab varies in options
depending on the type of logger connected.

2.3.3

Setting Alarm Options

The third tab (Alarms) allows you to define:
Alarms - each channel is configured independent of each other. Only
channels selected to be recorded are available for alarm testing. Alarms
are set by selecting the desired channel, selecting the alarm type and
specifying the alarm limits. Selecting the Inclusive check box will trigger
the alarm if the channel level is equal to the specified limits.
Example: If you select the Above upper limit alarm type and don’t select
Inclusive, the alarm is triggered if the measured value is greater than the
specified upper limit. Selecting Inclusive will cause the alarm to be triggered if the measured value is greater than or equal to the specified upper
limit.

NOTE: Each channel is independent and can have different alarm settings.
Simple Logger® II - DataView® Software
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Figure 2-5

NOTE: The values measured on current input models are limited to 1.1Vrms
max before the instrument displays an overload.
If you want to start the recording, click on the Recording tab, then select
Record Now followed by the OK button. This will write the configuration to the
instrument and begin a recording (provided enough memory is available).

NOTE: There is a 1 minute delay before a recording starts.
To save the configuration to the instrument and close the dialog box, click
the OK button.
Selecting the Cancel button will close the Configure Instrument dialog box
discarding the configuration changes.
Selecting the Help button will display the associated help topic.
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2.3.4

Configuring and Recording Data

The following is intended as an example.
You will configure the instrument to measure (and record) at a storage rate
of 5 Seconds over a recording period of 15 minutes with no alarms.
Note: The instrument’s clock should be set to the proper time as the clock
may vary due to time zones.
1. If a recording is active, stop it by selecting the Stop Recording
menu option.
2. Open the Configure Instrument window and select the
Recording tab to display the Recording page.
3. Select 5 Seconds from the Storage rate drop-down list (you
may need to use the vertical scroll bar to see this option).
4. Select the Start/Stop recording mode.
5. Select a 15-minute recording duration by selecting the
15 Minutes option from the Recording period drop-down list.
At this point the Recording page should look similar to Figure 2-6.

Figure 2-6
Simple Logger® II - DataView® Software
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6. Select the Scales tab to display the Scales page.
7. Select the Input scale, if available.
8. Select the Alarms tab to display and configure Alarm settings.
  9. To save the configuration before recording, see § 2.3.5 below.
10. To record, click on the Recording tab and check the Record
Now checkbox, then press OK. This will write the configuration to the instrument and begin a recording (provided enough
memory is available in the instrument).

2.3.5

Saving and Recalling a Configuration

Open the Configure Instrument window by selecting Configure from the  
Instrument menu.
To Save the Current Configuration to Disk:
•

Select the Save button. The Save As window will be displayed.

•

Specify a name for the file and type it into the File name field, then
specify a location to save it to.

•

Once the file name and directory have been specified, select the
Save button.

To Recall (Load) a Saved Configuration from Disk:
•

Select the Load button. The Open window will be displayed.

•

Specify the name of the file by typing it into the File name field, or
select it from the location where the configuration was originally
saved.

•

Once the file name and directory have been specified, select the
Open button. The configuration will be read from disk and the
Configure Instrument window will reset accordingly.

Selecting the Read button will read the configuration in the attached instrument and reset the dialog fields, accordingly.
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2.4

Displaying Real-time Status Information

Real-time data and instrument status is displayed in the Control Panel.

Figure 2-7

Connection Status - shows if instrument is connected/disconnected.
Instrument Identification:

Model - instrument’s model identification number.
Serial # - instrument’s serial identification number.
Firmware Rev - firmware revision of the attached instrument.
Memory:
Capacity - total amount of memory available for recorded data.
Used - amount of recording memory currently used.
Recording:
State - instrument’s recording state (Idle or Active).
Session - number of sessions currently stored in the instrument.
Time Remaining - amount of time remaining for the current recording
session (if one is active).
Recording Storage Rate - time between storage of measurement
data.
Simple Logger® II - DataView® Software
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Recording Mode - storage mode (Start/Stop, FIFO or XRM™).
Configuration:
Channel 1 and 2 - shows the configuration of each channel.
Battery:
Main battery - voltage of the main battery.
Input status:
Not in overload - displays the overload status.
No alarms have occurred - displays the alarm status.
Inst data/time - displays the date and time read from the instrument.

2.5

Resizing and Saving Real-time Window Layouts

A quick and easy way to arrange window layouts is done by clicking the
Arrange Windows icon
the window layout for you.

in the toolbar. This will automatically arrange

Real-time windows can also be resized and arranged to suit your needs by
using the mouse pointer. To move a window, simply click and hold on the
title bar, then drag to the desired location. To resize a window, click and
drag the corner of the window.
Once you have all of your windows in a desired location, you can save
your layout for future use.
To Save a Layout:
•

Go to File > Save Layout. Type in a name for the layout and
select the folder that you wish to save it in. Click on Save.

To Load a Layout:
•

2.6

Go to File > Load Layout. Locate and select a previously saved
layout file. Click on Open.

Displaying Real-time Graphs and Text

The following real-time windows can be opened and closed from the View
menu or the Status window:
Waveform (model dependent): The Waveform window displays line cycle
snapshots. This window displays the actual waveform relative to time.
20
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Figure 2-8

Harmonic (model dependent): The Harmonic window shows the harmonic
content of an associated line cycle using a bar graph or tabular textual
summary.  Depending on the selected radio button (Bar or Text).

Figure 2-9

Trend: The Trend window shows measurements (sample points) over a
time period.
Simple Logger® II - DataView® Software
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Figure 2-10

Displayed at the top of these windows is a list of available channels. Clicking on an entry will display the corresponding channel. You can select one
or more channels by using the Ctrl or Shift keys while making a selection.
The real-time update can be paused by clicking the Hold check box at the
bottom right of the window. The automatic update will stop until the Hold
check box is selected again. Graph magnifications can be increased, reset
and decreased by selecting the ++, +, 0, - and -- buttons.

2.7

Saving Real-time Measurements

Real-time data received from an instrument can be saved directly into a
recording session database. This differs from the process of downloading and saving recorded data in that the measurements are stored on the
computer as the instrument measures them. These measurements are not
necessarily being stored within the instrument. However, the instrument
may be configured to record at the same time real-time measurements
are being received from the instrument. In which case, two copies of the
measurements will be stored. One copy is stored on the local computer
and the other in memory within the instrument.
In addition, you can save waveform snapshots (when available) via the
Control Panel where the instrument does not capture and store waveforms. This provides functionality that extends the capabilities of the
Simple Logger® II.
To Save a Real-time Measurement:
1. To begin recording real-time measurements, select the Start recording
real-time data option from the File menu. When the Start recording
22
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real-time data option is selected, a dialog box will be displayed asking
for the name of the database to save the measurements into.
2. Specify the name of the database file by typing it into the File name
field or by selecting one from the displayed list. Next, select the desired
location to save the file. Select Save to save the file or Cancel to
return to the Control Panel.
3. If Save was selected, the Session Properties window displays.

Figure 2-11

The Session Properties dialog allows you to specify Operator, Site and
Custom parameters that are to be saved with recorded data. These parameters are used when generating reports.
The Operator and Site tabs allow you to maintain lists of operators and
sites, saving you time when specifying parameters for reports.
On the left of the Operator and Site tabs is the list of previously defined
Operators and Sites. On the right of the Operator and Site tabs is the
individual parameters that will be saved in an associated database. Only a
single set of operator and site fields are saved in the recording database.
The Custom tab contains a list of user defined parameters. Along side
each user defined parameter is a check box.  Items that are checked will
be added to an associated database. Only a single set of Custom parameters can be maintained (unlike the Operator and Site lists). The Custom
Simple Logger® II - DataView® Software
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tab allows you to specify any user defined parameters (in addition to the
comments field of the Site tab) that are to be used in displaying a report.
4. Type the appropriate information into the fields, then click OK.
5. Measurement data will be saved until the Stop recording real-time
data option is selected from the File menu.  When you stop recording
real-time data, you will be asked if you want to open the database.
6. Answering Yes will bring the main DataView® window to the foreground
and the Create View from Template window will be displayed.

Figure 2-12

This window allows the user to specify a template for the database that
was just downloaded and saved. A suggested template will be selected.
Either accept this template or select another one.
7. After selecting a template to use, select the OK button.  A report will
be displayed in the main DataView® window containing the recorded
sample data in the format associated with the template.
8. To save the report, go to File > Save and save the file in the desired
location.
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2.8

Downloading Recorded Instrument Data

Recorded measurements stored in the instrument are transferred to a
database on the PC using the download command. Assuming a recording
session has been started and stopped, the instrument should have at least
one recorded measurement inside it.
To Download a Recording:
•

Select Download from the Simple Logger® II’s Instrument menu
or click the Download button on the toolbar. This begins the transfer of recorded data to the computer. A window displaying the
transfer progress will be displayed.

•

Once the transfer is complete, the Save As dialog box will be displayed.

•

In the Save As dialog box, specify the name of the database in
which to save the recorded data. If a database exists with the
name you specify, a dialog box asking if it should be overwritten
will be displayed. Selecting the No button will allow you to specify
another database name. Selecting the Yes button will overwrite
the database.

•

Once a database file name is specified, the Session Properties
dialog box will be displayed. Complete the information in this
dialog box, then click OK.

•

Once the download has completed successfully, you will be asked
if you want to open it. Selecting Yes will open DataView® (if not
already open) and bring it to the foreground. The Create View
from Template will be displayed with a default template already
selected and the downloaded database specified as the database
to be opened. You can accept the defaults by selecting OK or
select a different template.

Simple Logger® II - DataView® Software
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2.9

Simple Logger® II Templates

Refer to the DataView® Help files for detailed information about using the
logger templates.
Trend Summary Report Template
The Trend Summary Report template is for use with the Simple Logger® II
and generates a view with four worksheets. The worksheets contained in
this report include the following:
• Cover Sheet
• Trend List
• Alarms
• Instrument Configuration
You can move between the worksheets by selecting the desired worksheet from the worksheet tabs at the bottom of the view (just above the
status bar).
The first worksheet is the Cover Sheet and provides information about the
recording session.  The following illustrates the Cover Sheet:

Figure 2-13
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The Cover Sheet is used as a cover sheet for the report and contains the
following frames:
•

•
•
•
•
•

Text Box - containing the text “Trend Summary Report”.
Session Summary - containing the name of the database used
to generate the report.
Session Summary - containing operator information.
Session Summary - containing test site information.
Session Summary - containing operator comments.
OLE - containing the AEMC® Instruments logo.

Using the associated properties window customizes each of these frames.
The properties window for a frame is displayed by selecting the frame,
then selecting the Properties command from the Frame menu.
The second worksheet is used to view the recorded trend channels and
contains the following frames:
• Channel Graph
• Session Summary
• Trend Summary List
The following illustrates the Trend List worksheet:

Figure 2-14
Simple Logger® II - DataView® Software
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The third worksheet is for displaying alarms that were recorded.

Figure 2-15

The Alarms worksheet (Figure
2-15) allows you to select a
channel from the channel list.
The Exception List will then be
updated to list the exceptions
(if any) that occurred on the
selected channel. You can then
select exception and the graph
time frame will be adjusted to
display the trend samples in the
exception period.
The last work sheet (Figure
2-16) is used to display the configuration of the instrument that
recorded the session data. This
is the configuration of the instrument while it was recording this
data.

Figure 2-16
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Channel Graph Frame
A Channel Graph frame provides a graphical look into the database it is
attached to. The database is attached to the Trend Graph frame when it is
created.  This can be done manually by placing a graph frame or automatically when using a template.
The graph frame provides additional tools for viewing the underlying database. These tools provide zoom and pan operations. In addition, individual
traces and waveform snapshots can be selected using the Select Frame
tool.
Normally, the Select Frame tool is used to select a frame for modification.
In addition to selecting the Graph frame, this tool is used to select individual
traces. A trace is selected if any part of it is drawn within a few screen pixels
of where the selection tool is when the left mouse button is pressed.
When a trace is selected, handles similar to those of the frame handles
are drawn over the trace. If more than one trace is drawn within the proximity of the selection tool, when clicked again, the next trace will be selected. This will continue until all traces within the selection tools proximity
have been selected. At which point, clicking the left mouse button again
will select the first trace and the process will repeat.
Frames can be linked together so that when you select a trace or line in
one frame another frame shows additional information about the selection.  
For example when selecting a trace in the graph the trend summary list
will be updated to list the sample points for the selected trace.
Linking frames can create a complex interaction between frames.  For additional information refer to the DataView® users guide accessible from the
help menu of the main DataView® application.
This template contains the following linked frame types:
• Session Summary
• Channel List
• Meter
• Trend Summary List
The channels selected for display and the display properties can be
changed at any time using the Channel Graph Properties window. The
Channel Graph Properties window can be displayed by right-clicking the
mouse pointer while positioned over the Graph frame, then selecting Properties from the drop-down menu.
The display extents of the Channel Graph frame can be changed by using
zoom and pan operations. By zooming and panning you change the starting and ending times of the displayed data. By changing the starting and
ending display times, you can zoom in, zoom out, pan left and right, pan to
start and pan to end of measurement data.
Simple Logger® II - DataView® Software
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To change the display extents of a graph frame, select the frame using
either the frame selection tool
or Zoom Tool
. Next, use a zoom or
pan command from the Zoom menu, or from the toolbar. By clicking and
dragging the Zoom Tool across the desired area of the graph, you can
select an area to zoom in on.
Channel List Frame
The Channel List frame is a frame attached to either a Channel Graph or
Micro-Graph frame. In the case of this template, the parent is a Channel
Graph frame. The Channel List frame displays a textual list summary of
the channels available in the recording. Each summary line contains userspecified parameters of a specific channel recording.
You can specify the displayed parameters and general display options using the Channel List Properties dialog box.
You can step between list entries. Selecting Pan To Start, displays the
first list entry. Selecting Pan To End, displays the last list entry. Selecting
the Step Right or Step Left, displays the next or previous list entry. When
stepping through the captured list entries, the selection will move from
each entry for the associated channel.
In addition to stepping through the list with the tool bar, you can select a
specific entry listed using the mouse pointer. The text for the selected entry
will be highlighted, indicating which entry in the list is currently selected.
Session Summary Frame
The Session Summary frame is a frame attached to the Channel Graph
frame. This frame displays a textual summary of its parent frame. You
can customize the summary text displayed, using the Session Summary
Properties dialog box. This dialog box is displayed by right-clicking on the
frame and selecting Properties from the drop-down menu, or by doubleclicking on the frame.
The Trend template contains Session Summary frames displaying the
following information:
•
•
•
•
•
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Start time and duration of the recorded data and the instrument’s
identification codes. This frame is in the upper right corner of the first
worksheet.
Database containing the file name and location of the recording data
Operator information
Test site information
Operator comments
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The text displayed in the session summary frames is static as long as
the data within the associated database remains static. Session Summary
frames do not provide the interactive operations available in the Channel
Graph and Trend Summary List frames.
Meter Frame
The Meter frame is a frame linked to the Channel Graph frame. The Meter
frame displays the values of samples at a specific location on the graph.
Left-clicking on the graph displays a black vertical bar. The sample values
displayed in the meter frame are associated with the time at the location
of this vertical bar.  Left-clicking at other areas of the graph will move the
vertical bar and update the Meter frame accordingly.
Text Box Frame
A Text Box frame displays text at a given location on the page. The text
within the frame is static, in that it does not change. It only changes when
you change it. This template contains a Text Box located at the top of the
worksheet. The text displayed within this frame is the title of this report
(Trend Summary Report). The text, font and other frame properties can be
changed using the Text Box Properties dialog box.

NOTE: For more information on using the Simple Logger® II Control Panel or
DataView®, refer to the Help Files within the software.

Simple Logger® II - DataView® Software
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WARRANTY
With respect to the physical CD and physical documentation enclosed herein, AEMC® Instruments warrants the same to be free of defects in materials and workmanship for a period of
one year from the date of purchase. In the event of notification within the warranty period
of defects in material or workmanship, AEMC® Instruments will replace the defective CD or
documentation. The remedy for breach of this warranty shall be limited to replacement and
shall not encompass any other damages, including but not limited to, loss of profit, special,
incidental, consequential, or other similar claims.
AEMC® Instruments specifically disclaims all other warranties, expressed or implied, including but not limited to, implied warranties of merchantability and fitness for a particular purpose with respect to defects in the CD and documentation, and the program license granted
herein in particular, and without limiting operation of the program license with respect to any
particular application, use or purpose. In no event, shall AEMC® Instruments be liable for any
loss of profit or any other commercial damage, including but not limited to, special, incidental,
consequential or other damages.
What You Must Do: First request a return authorization form by phone or by fax from AEMC®
Instruments, then return the CD along with the signed authorization repair form. Return material, postage pre-paid to:
Chauvin Arnoux®, Inc. d.b.a. AEMC® Instruments
15 Faraday Drive • Dover, NH 03820 USA
Tel: (800) 945-2362 or (603) 749-6434 • Fax: (603) 742-2346

COPYRIGHT
Copyright 2000 by AEMC® Instruments. All rights reserved. No part of this manual or DataView® software may be reproduced in any form or by any means (including electronic storage and retrieval or translation into any other language) without prior agreement and written
consent from AEMC® Instruments, as governed by United States and International copyright
laws.
Chauvin Arnoux®, Inc. d.b.a. AEMC® Instruments
15 Faraday Drive • Dover, NH 03820 USA
Tel: (800) 945-2362 or (603) 749-6434 • Fax: (603) 742-2346
Acknowledgements for product names used in this manual belong to the following companies: Windows® is a registered trademarks of Microsoft® Corp. Adobe® Reader is a registered
trademark of Adobe Systems Incorporated.

DISCLAIMER
The DataView® software and this documentation are provided “AS IS”, without warranty of
any kind. By using this program (the DataView® software) you are assuming all liability for
anything which might occur, including but not limited to physical, emotional or monetary
damages.
AEMC® Instruments has made every attempt to ensure that this program operates properly.
Due to the complexity of any program of this size, a change made in one part of the program
can, and sometimes does, inadvertently generate problems in other areas. It is recommended that you save your work regularly (BACK UP your software).
No part of this manual may be reproduced in any form, or by any means (including electronic
storage and retrieval or translation into any other language) without prior agreement and
written consent from AEMC® Instruments, as governed by United States and International
copyright laws.
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